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About the Tutonal

Microsoft Office Word 2010 allows you to create and edit personal and business
documents, such as letters, reports, invoices, emails and books.

By default, documents saved in Word 2010 are saved with the .docx extension. Microsoft
Word can be used for the following purposes:

e To create business documents having various graphics including pictures, charts,
and diagrams.

e To store and reuse readymade content and formatted elements such as cover pages
and sidebars.

e To create letters and letterheads for personal and business purpose.
e To design different documents such as resumes or invitation cards etc.

e To create a range of correspondence from a simple office memo to legal copies and
reference documents.

Audience

This tutorial has been designed for computer users who are willing to learn Microsoft Word
in simple steps and they do not have much knowledge about computer usage and Microsoft
applications. This tutorial will give you enough understanding on MS Word from where you
can take yourself to higher levels of expertise.

Prerequisites

Before you begin with this tutorial, we assume you have a basic understanding of
Computer peripherals like mouse, keyboard, monitor, screen, etc. and their basic
operations.

Copyright & Disclaimer

© Copyright 2018 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I)
Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish
any contents or a part of contents of this e-book in any manner without written consent
of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as
possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt.
Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our
website or its contents including this tutorial. If you discover any errors on our website or
in this tutorial, please notify us at contact@tutorialspoint.com
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1. Word 2010 — Getting Started

In this chapter, we will discuss how to get started with Word 2010. We will understand
how to start a Word 2010 application in simple steps. Assuming you have Microsoft Office
2010 installed in your PC, to start the Word application, follow these steps:

Step 1: Click the Start button.

Start Button
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Step 2: Click the All Programs option from the menu.

All Programs
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Step 3: Search for Microsoft Office from the submenu and click it.

frosaty Oftce 00 Doy Tt - Dot

jrosett OMce Viso 2000 .

Microsoft Office
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Step 4: Search for Microsoft Word 2010 from the submenu and click it.

™

LI

[

Microsoft Word 2010

This will launch the Microsoft Word 2010 application and you will see the following window.
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2. Word 2010 — Explore Window

In this chapter, we will understand how to explore Window in Word 2010. Following is the
basic window which you get when you start the Word application. Let us understand the

various important parts of this window.

Quick Access toolbar 3
: Title bar
File tab ) Rilae
Ribbon Help
9 -y V.ls Documentl - Microsoft Word . » IF"@*
Home | Insert \JyPage Layout References Mailings Review \jew Add-Ins & 9
¥ 4 Calibri(Bo *11 v ZeiSeNTe EEE
Depadn S5 3 i E & A A
4 2 B Z U-aex, x' & EEXNER- =
Paste ab ~ o | f= A N Styles Editing
v J I AY-A A A A |PPulee ] BB % >
Clipboard Font Paragraph
@ DTS P S NS R Y R A SRS U RS AR 9 - 110 - [
J ' ' ) . ' i '
& Dialog Box Launcher
% A
. v
i - 2
~ o
' 5 g ¥
S * B VR 3
Page:1ofL jpWords0 | P | engishus) | |[ED R 2 8 120% ) 0 (+)
1 L

Status bar Document area

File Tab

View buttons

Zoom control

The File tab replaces the Office button from Word 2007. You can click it to check the
Backstage view. This is where you come when you need to open or save files, create
new documents, print a document, and do other file-related operations.
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Quick Access Toolbar

This you will find just above the File tab. This is a convenient resting place for the most-
frequently used commands in Word. You can customize this toolbar based on your comfort.

Ribbon
Home | Insert Page layout References Mailings Review View Add-Ins & @
Calibri (Bod 11 v = i=eNzy  (ESE
ibri (Body) =T 3= - 2P = A )
B 7 U-aex, x & [ EE 3N !=-
o | 2 Styles Editing

% AvAar A A 9 D |29 f 4

Ribbon contains commands organized in three components:

e Tabs: These appear across the top of the Ribbon and contain groups of related
commands. Home, Insert, Page Layout are examples of ribbon tabs.

e Groups: They organize related commands; each group name appears below the
group on the Ribbon. For example, group of commands related to fonts or group of
commands related to alignment, etc.

¢ Commands: Commands appear within each group as mentioned above.

Title bar

This lies in the middle and at the top of the window. Title bar shows the program and
document titles.

Rulers

Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler appears
just beneath the Ribbon and is used to set margins and tab stops. The vertical ruler
appears on the left edge of the Word window and is used to gauge the vertical position of
elements on the page.

Help

The Help Icon can be used to get word related help anytime you like. This provides nice
tutorial on various subjects related to word.

Zoom Control

Zoom control lets you zoom in for a closer look at your text. The zoom control consists of
a slider that you can slide left or right to zoom in or out; you can click the + buttons to
increase or decrease the zoom factor.

View Buttons

The group of five buttons located to the left of the Zoom control, near the bottom of the
screen, lets you switch through the Word's various document views.
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e Print Layout view: This displays pages exactly as they will appear when printed.
e Full Screen Reading view: This gives a full screen view of the document.

e Web Layout view: This shows how a document appears when viewed by a Web
browser, such as Internet Explorer.

e Outline view: This lets you work with outlines established using Word’s standard
heading styles.

e Draft view: This formats text as it appears on the printed page with a few
exceptions. For example, headers and footers aren't shown. Most people prefer this
mode.

Document Area

This is the area where you type. The flashing vertical bar is called the insertion point and
it represents the location where text will appear when you type.

Status Bar

This displays the document information as well as the insertion point location. From left to
right, this bar contains the total number of pages and words in the document, language,
etc.

You can configure the status bar by right-clicking anywhere on it and by selecting or
deselecting options from the provided list.

Dialog Box Launcher

This appears as very small arrow in the lower-right corner of many groups on the Ribbon.
Clicking this button opens a dialog box or task pane that provides more options about the

group.

w Mtutorialspoint

EIMPLYEAESEYLEARMNING



3. Word 2010 — Backstage View

In this chapter, we will discuss the Backstage View in Word 2010. The Backstage
view was introduced in Word 2010. This acts as the central place for managing your
documents. The backstage view helps in creating new documents, saving and opening
documents, printing and sharing documents, and so on.

Getting to the Backstage View is easy: Just click the File tab, located in the upper-left
corner of the Word Ribbon. If you already do not have any opened document, then you
will see a window listing down all the recently opened documents as follows:

File tab
Documentl - Microsoft Word l E.l_
Insert Page layout References Mailings Review View Add.Ins ¢ 9
E Y
e save
Recent Documents Recent Places
B save As
~ ﬂ 42375 _Ku... - > Desktop &
(=7 Open @ : Desktop @ ' =  C\Users\zara\... ’
P Y > » ~ -
[y Close Wl T- Tracker... o final_tutorials
lj = C:\T-Trac... Q v/ C:\Users\zara\... e
Info v R T
Wl  word tute... : sembly -
. l:] l My Docu... ¢ e  C:\Users\Books...
‘ @@ Workord.. 5, St
i Desktop U/ C\Users\Books... =
Hiew @u Work Ord... > T-Tracker s
Desktop s/ C\T-Tracker 3
Print
L\_—!E java.odt -
| Save & Send . Desktop
@,\ chll Proc.. .
Help Desktop\fi.. = |w
o)
{72 Add-Ins ~ S4hs
L L_| Quickly access 4 R
| 2] Options this number of i

If you already have an opened document, then it will display a window showing detail
about the opened document as shown below. Backstage view shows three columns when
you select most of the available options in the first column.
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First Column

Second Column

Word 2010

Third Column

ol e s

Fecent

i Fac docr [Compordiie, Mode] - Marosoht Woed
Foge imat ot erencey Vanng Pevew Ve

Information about ch14_Recursion

CAVserd' 200w\ Desitog’ Final_ hutonalt\ ch d_Recuruon doce

Compatibiiry Mode
'

Beadied 10 prtn ent prodiomn ahen morting weh

i g #i e, Comanmang th fde md enable these fartires
A PP youR Aanges
g Permissions
i .
), Anyond Con epen (Opy. and CNAAGE sy Pant of s SCCurmant
Protect

Oocument *

Prepace for Sharing
Betare Darrg tha Lie. ba sasre that £ contan

Documert progetay and pthor | rarme

Check
S Contert that Canmat Ba Chect 0 v aCCendiny ayes 2e< pute of
hown
the (wmert fde type

Vertiont

3 Thase e 00 provioss varvong of thes fie
.
Marage
Vervon

feated Cem

Teistes Pesgn

!

The first column of the backstage view will have following options:

Option

Description

Save If an existing document is opened, it will be saved as is, otherwise it will
display a dialogue box asking for the document name.

Save As | A dialogue box will be displayed asking for document name and document
type, by default it will save in word 2010 format with extension .docx.

Open This option is used to open an existing word document.
Close This option is used to close an open document.
Info This option displays information about the opened document.

Recent This option lists down all the recently opened documents
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New This option is used to open a new document.

Print This option is used to print an open document.

Save & This option will save an open document and will display options to send the
Send document using email, etc.

Help This option is used to get the required help about Word 2010.

Options | This option is used to set various option related to Word 2010.

Exit Use this option to close the document and exit.

Document Information

When you click the Info option available in the first column, it displays the following
information in the second column of the backstage view:

Compatibility Mode: If the document is not a native Word 2007/2010
document, a Convert button appears here, enabling you to easily update its
format. Otherwise, this category does not appear.

Permissions: You can use this option to protect your word document. You can set
a password so that nobody can open your document, or you can lock the document
so that nobody can edit your document.

Prepare for Sharing: This section highlights important information you should
know about your document before you send it to others, such as a record of the
edits you made as you developed the document.

Versions: If the document has been saved several times, you may be able to
access the previous versions of it from this section.

Document Properties

When you click the Info option available in the first column, it displays various properties
in the third column of the backstage view. These properties include the document size,
the number of pages in the document, the total nhumber of words in the document, the
name of the author etc.

You can also edit various properties by clicking on the property value and if the property
is editable, then it will display a text box where you can add your text like title, tags,
comments, Author.

12
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Exit Backstage View

It is simple to exit from the Backstage View. Either click on the File tab or press the Esc
button on the keyboard to go back to the working mode of Word.

13
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4. Word 2010 — Entering Text

In this chapter, let us discuss how to enter text with Microsoft Word 2010. Let us see how
easy it is to enter text in a Word document. We assume you know that when you start
Word, it displays a new document by default as shown below:

7 e ——— Y
Wi d9~0ls Documentl - Microsoft Word ID'@M
Home | Inset Page layout References Mailings Review View Add-Ins & 6
2 ¥ o v v =v Jmviime | S &
j 4 Calibri (Body) 11 A R ii £ A A
— 3 B I U-hex, x| |EEES = sniet| eaig
Paste o v | e p es ting
v J| B XA A | A | O ) | PR
Clipboard & Font p Paragraph
[Z] » 1i . 1 . 1 . 1 R B0 1 . < 1 R T 1 . 5 ' T D ’;.—:]
i § ¥ ¥ O v -._:_
IG)
..
< Text Insertion Point
!
I A
v
~ 3
g Q
I :
€ | B | > »
Page:1of1 | Words:0 | 6  English (U.S) ||(}[:]£3 3 = | 204% (=) (J {+)
Document Area

Document area is the area where you type your text. The flashing vertical bar is called the
insertion point and it represents the location where the text will appear when you type.
keep the cursor at the text insertion point and start typing the text. We typed only two
words "Hello Word" as shown below. The text appears to the left of the insertion point as

you type:

14

@ tutorialspoint

EIMPLYEAEYLEARMNING



Word 2010

wHd9-0s Documentl - Microsoft Word l = M
Home | Insert Page Layout References Mailings Review View Add-Ins & 0
==l )4 Calibri (Body) 11 v ==ty IEEE Alllga
B 53 B 7 U-shex, x & |BE=EEBE-|I= S |5
Paste a o | - es iting
v F R E-LA-ra | K0 | @B T -

Clipboard % Font P Paragraph »
._.C‘ : - - : - - . s : - - -—
g é | 1 : | 2 |' 3 \ ' 4 | S. | 3 .@
@
FN
Hello Word....
v
o N
(o]
= ¥
1 L w ] B
Page:1ofl | Words:2 | <6 English(us) ||[E|H R = = 204% (=) ()

The following are the two important points that will help you while typing:

e You do not need to press Enter to start a new line. As the insertion point reaches
the end of the line, Word automatically starts a new one. You will need to press
Enter, to add a new paragraph.

e When you want to add more than one space between words, use the Tab key
instead of the spacebar. This way you can properly align text by using the
proportional fonts.
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5. Word 2010 — Move Around

In this chapter, we will discuss how to move around in Word 2010. Word provides a number
of ways to move around a document using the mouse and the keyboard.

To begin with, let us create some sample text. To create a sample text, there is a short
cut available. Open a new document and type =rand() and press Enter. Word will create
the following content for you:

o i : =
Wi d9-0 = Documentl - Microsoft Word o I,@'@g
Home | Insert Pagelayout References Mailings Review View Add-Ins & 0

o s - - L £ — = s
i & Calibri (Bo vil]l] ©v| = e i= v 3ev | SE S
‘j o) ! '( CM 1 ,: 3 — ".- = =F A‘ %
“— iy B Z U-adex, x| & |[E¥F NN =
Paste i A o | - A Styles Editing
v J| A 2-AAr| AN (| BT 41 - .
Clipboard Font . Paragraph M
E] l-u-l-:-l-2~'-3-l-4-n-s'l-5---7-l-8-1-9-1-10-'-11-'12-"13%-144"\-15-!-16-,.@7
J . L) ’ L) ) ) ' ) L) L] L) b
= )
||
"-_‘ Pn the Insert tab, the galleries include items that are designed to coordinate with the overall ‘ l 'l
S look of your document. Youcan use these galleries toinserttables, headers, footers, lists, 1=
2 cover pages, and other document building blocks. When you create pictures, charts, or ‘ ' |
&5 diagrams, they also coordinate with your current document look. — ‘
; You can easily change the formatting of selected textin the document text by choosing a |
2 look for the selected text from the Quick Styles gallery onthe Home tab, Youcan also format |
- text directly by using the other controls on the Home tab. Most controls offer a choice of |
= using the ook from the current theme or using a format that you specify directly.
(T
o To change the overall look of your document, choose new Theme elements on the Page
& Layout tab, To change the looks available inthe Quick Style gallery, use the Change Current
2 Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset 5 ‘
~ commands sothat you can always restore the look of your document tothe original 2 ﬂ
:— contained inyour current template. o
= ¥
S 1 m B 7 | gl
Page:10f1 | Words:185 | <5 | (DnRs s 8% (- —U on
Moving with Mouse

You can easily move the insertion point by clicking in your text anywhere on the screen.
There may be instances when a document is big and you cannot see a place where you
want to move. Here, you will have to use the scroll bars, as shown in the following
screenshot:

16
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f@f = Rl Gl Documentl - Microsoft Word . l =) @

Home | Insert Pagelayout References Mailings Review View Add-Ins & 9

€ ) Calibri (Bod 1 v == | EEE -
J J ( y) l ’¥. _’ — 3 ’ E A %
‘; L, A B 7 U-aex, x' & EEZEE- (= Shyies | Edifino
aste -~ v | =
Z j v a_b) - A v Aa v A A ‘ )“ “‘ & v i v 21 q‘r v -

Clipboard % Font p Paragraph "

(L] L 1 10121 3+ 1 4+ 51 601 71 8191401 -11---12<l-13~--14-;»K;15-!-15'lf§j
e u l_ ) ) % ) ) [ 1 . 1] 1 = [ \_F,
5 Layout tab. To change the looks available inthe Quick Style gallery, use the Change Current < |
= Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset —
~ commands sothat you canalways restore the look of your document to the original
~|  contained inyour current template.
= Scroll Down —
- \
o Vertical Scroll Bar——> ‘
g i
= |
- '
f;A
= |
& Horizontal Bar
3 ScrollUp —>~ '
T Previous Page >2
2 Browse Objects ——>0
o Next Page 3¢
4 ' I >
Page:1 of 1 | Words: 185 | \',/a | |’§? R ZE2E 8% ai} {} i -

You can scroll through your document by rolling your mouse wheel, which is equivalent to
clicking the up-arrow or down-arrow buttons in the scroll bar.

Moving with Scroll Bars

As shown in the above screenshot, there are two scroll bars: one for moving vertically
within the document, and one for moving horizontally. Using the vertical scroll bar, you
may:

¢ Move upward by one line by clicking the upward-pointing scroll arrow.

¢ Move downward by one line by clicking the downward-pointing scroll arrow.
¢ Move one next page, using the next page button (footnote).

e Move one previous page, using the previous page button (footnote).

e Use the Browse Object button to move through the document, going from one
chosen object to the next.
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Moving with Keyboard

The following keyboard commands, used for moving around your document, also move
the insertion point:

Keystroke Where the Insertion Point Moves
—_ Forward one character
“— Back one character
1\ Up one line
‘1, Down one line
PageUp To the previous screen
PageDown To the next screen
Home To the beginning of the current line
End To the end of the current line

You can move word by word or paragraph by paragraph. You would have to hold down the
Ctrl key while pressing an arrow key, which moves the insertion point as described here:

Key Combination Where the Insertion Point Moves
Ctrl + —> To the next word
Ctrl + < To the previous word
Cirl + 1\ To the start of the previous paragraph

18
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Ctrl + ¢ To the start of the next paragraph

Ctrl + PageUp To the previous browse object

Ctrl + PageDown | To the next browse object

Ctrl + Home To the beginning of the document
Ctrl + End To the end of the document
Shift + F5 To the last place you changed in your document.

Moving with Go To Command

Press the F5 key to use the Go To command. This will display a dialogue box where you
will have various options to reach to a particular page.

Normally, we use the page number, the line number or the section number to go directly
to a particular page and finally press the Go To button.

r -
Find and Replace M

_Fnd | Reglace | GoTo

Go to what: Enter page number:

O . | 50

Section =

Line 1| Enter + and - to move relative to the current location. Example: +4 will
Bookmark move forward four items.

Comment

\Footnote =4
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6. Word 2010 — Save Document

In this chapter, we will discuss how to save a document in Word 2010.

Saving New Document

Once you are done with typing in your new Word document, it is time to save your
document to avoid losing work you have done on a Word document. Following are the
steps to save an edited Word document:

Step 1: Click the File tab and select the Save As option.
FileI tab SaveAs

& Bl E Documentl - Microsoft Word l =HEC M
Home Insert Page Layout References Mailings Review View Add.Ins ~ 0
.
i Save .
) Information about Document1 |
( Bl Save as f
7 Open . Permissions :
‘.J Close :!_", Anyone ¢an open, copy, and ——
change any part of this
Protect document
. Properties *
info Document » P
Size
Recent Pages
Words
Now s Prepare for Sharing Total Editing Tia
73 Before sharing this file, be aware Title
that it contains: e
Print Check for Document properties and 93
Issues - author's name Comments
Save & Send Related Dates
Help z Versions Last Moditied
/\ﬂ A) There are no previous Created
:J Add-Ins ~ versions of this file. Last Printed
Manage
. " Versions ~
& Options Related People
a m Author
Last Modified B
‘ 1 ’
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Step 2: Select a folder where you will like to save the document, Enter the file name which
you want to give to your document and Select the Save As option, by default it is the

.docx format.

Folder to save the document

(W] Save As -
m | 4 » Libraries » Documents » 'l" H Seorch Documents ol
TR—— = =
Organize v New folder 5% - ﬂ
(W] Microsoft Word Documents Ilbrary Amangeby: Folder *
|, Templates Includes: 2 locations
5 | Activision . DigiFish Dolphin 1. My PSP Fi
. it
(-a;mk:s J. Adobe Scripts , Downloads QMyShap
Des Tp . J. Android , Fonts 1. My Statio
‘ oown S J. Aptana Studio 3 Workspace . Google Talk Received Files |, Pascal
, R“m‘;' |, ASP  idooDVD ShadowE
R e | Bluetooth Exchange Folder | LDW 3. Softwrap
a. Config , microsoft |, switch sta
|| ' Desktop .
i | cpp_goto_statement_file |, My Corel Shows |, Symantec
ran
b st J. Cyberlink . My DAP Downloads |, templates
' A\ * Documents
o' Music - < n ’
File pame: Hello.docx >
wd
Save as type: | Wofd Document (*.docx) v]
" A
Authors: zara Add atag
=1 Spve Thumbnail
| = |Hide Folders Tools ~ L Save ] l Cancel !
Folder Names File Name Document Type

Step 3: Finally, click on the Save button and your document will be saved with the
entered name in the selected folder.

Saving New Changes

There may be an instance when you open an existing document and edit it partially or
completely, or an instance where you may like to save the changes in between editing of
the document. If you want to save this document with the same name, then you can use
either of the following simple options:
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e Just press the Ctrl + S keys to save the changes.

e Optionally you can click on the floppy icon available at the top left corner and just
above the File tab. This option will also help you save the changes.

e You can also use the third method to save the changes, which is the Save option
available just above the Save As option as shown in the above screenshot.

If your document is new and it was never saved so far, then with either of the three

options, Word will display a dialogue box to let you select a folder, and enter the document
name as explained in case of saving new document.

22
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7. Word 2010 — Opening a Document

In this chapter, we will discuss how to open a document in Word 2010.

Opening New Document

A new, blank document always opens when you start Microsoft Word. Suppose you want
to start another new document while you are working on another document, or you closed

an already opened document and want to start a new document. Here are the steps to
open a new document:

Step 1: Click the File tab and select the New option.

File tab New option Template List
W, umentl - Microsoft Wored e e o < (5
Mome insent Page Layout Referent Mpitengs Review View aAgdins 0
bl Sove
Available Templates Blank document
Bl Sove as
. @ Home
f| & Oven
3 Oose =
info (= l V. |
J 4 I
5 \
Blank Blog post Recent 1
document templates

. &

Sample My templates  New from
templates eusting

Office.com Templa.. earch Officecon

"‘, ‘_‘/ ". _,/ v:/ _/

Access Agendss Books 3
databases -

Create

W Y
Brochures Budgets Business
and booklets cards

Step 2: When you select the New option from the first column, it will display a list of
templates in the second column. Double-click on the Blank document; this is the first
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option in the template list. We will discuss the other templates available in the list in the
following chapters.

You should have your blank document as shown below. The document is now ready for
you to start typing your text.

[ -0 ls Document6 - Microsoft Word l"‘:’l"@f -
Home Insert Page Layout References Mailings Reéview View AddIns & o
% Calibri Body) 11 v ELELNEe EE a;, % PO
L B I U-dexx % EEZIR- = iy et
> S 45 uick Change s
S AV -A-A A PEv B 8T sitese sese | -
Clipboard & Font » Paragraph ~ Styles .
ﬁ{.,. Al e 2 i3 g S B T B o9 230 b o1l h o120 11301 24 k‘s.'.“.?t-
. xl = . L) 1 ] . L) ) 11’ l 1) = . x‘ X l.:‘ﬂ
{«]
-~
L
i
I
'
v
2
o
3
Page:10f1 | Words:0 | D  English US) | (Bl am &% o—~O0 +) I
l — y

You can use a shortcut to open a blank document anytime. Try using the Ctrl + N keys
and you will see a new blank document similar to the one in the above screenshot.
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Opening Existing Document

There may be a situation when you open an existing document and edit it partially or
completely. Follow the steps given below to open an existing document:

Step 1: Click the File tab and select the Open option.

File tab Open option

(w] afF s Documentl - Microsoft Word keh®
Home Insent Page Layout References Mailings Review View Add.ins 0
-~
b save .
Information about Document1
B Savefs
: |
7 Open a Permissions |
[ Close __.”’ Anyone can open, copy, and ———
change any part of this
P
l)\:»:'umcmo“(t . Gocment Propesties © I
Sae ot ¢
Recent Pages !
R Words 185
N S Prepare for Sharing Total Edting Time 749 Minutes| ||
{ j Before shanng this file, be aware 5
: that it containg: o
Print Check foc Document properties and s
Issues - author’s name Comments
I Save & Send Related Dates
i Last Modfied
| Help — Versions
1. A) There are no previous Created Today, 03:13
5 | »
2 4 Adddns ~ M versions of this file. Last Printed
- Versions ~
lons
_l Opt - Related People
a £t Author a0
‘ 4
Last Moddied By Ot saved
A Show All Prooerties s
4 »
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Step 2: This will display the following file Open dialog box. This lets you navigate
through different folders and files, and also lets you select a file which you want to open.

Folders Folders & Files
" — — =)
» Libraries » Documents » ,W”Smmo“uwm ;‘1
e = e ) s e —— _‘
3 0 O

W Favorites
Bl Desktop
8 Downloads
Bl Desktop
3. Recent Places

B Desktop

w4 Libranes
|+ Documents
o Music

e Pictures
B videos
B 2

Documents library

Includes 2 locations v

). 1dooDVD b templates

. Low 4. Winnydows

J. microsoft ) ASP.NET.doc

4 My Corel Shows @) ASP.NET.docx

J. My DAP Downloads £  bigloop.html
EMy Shapes Vig coohtml |

J. My Stationery £ <pp._goto_statement.htm
4. Pascal £ developers.html
a. Softwrap £ Nonamel html

4 switch statement file £ Noname2 html

4. Symantec g1 Online HTML Editor.mht

m J
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Atrange by:  Folder ~

) Project Management.docx
#)Python Functions.doc

£ switch statement htm

) table class.docx

£ VOIP.htmi

£ website-templates.htm
) WMS.docx

&) word tutorial docx

£ XMUhtml

»

- [AIW«dDomhr.dooc’.c v]

Toos ~ [_Qpen [v] |

Concel |
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Step 3: Finally, locate and select a file which you want to open and click the small triangle
available on the Open button to open the file. You will have different options to open the
file, but simply use the Open option.

[W] Open r .
®'[ < » Libraries » Documents » -]6, m Search Documents Pl
— - - S
Organize v New folder 3~ A @O

(W] Microsot Word 4 Documentts library

Arrange by:  Folder ~

L. Templates Includes: 2 locations
e Fais | koW #) ASP.NET.doc &) table class.docx
J..Dv::“ = , J. microsoft ) ASP.NET.docx £ VO .htmi
2 Oow :: & J. My Corel Shows £ bigloop.html £ website-templates.htm
‘ Desl: J. My DAP Downloads £ billing.htm S)WMs.doox
@ R o‘:,h( | MyPSP Files Vi ces.html &) word tutorial.docx
S &3 My Shapes £ <pp_goto_statement htm £ XMUbtm
D ). My Stationery £ developers.htmi
2 T:” b Pascal £ jsphtm
= ."o;ns ShadowEditFiles £ Nonamel.html
: “I N Documer g Softwrap £ Noname2.html
Public Doc 1. switch statement _file 0 Online HTML Editor.mht
J,;l Riassis 4. Symantec &) Project Management.docx
K 1. templates #)Python Functions.doc
;‘ vomncs 4. Winnydows £ switch statementhtm
B 2 - 74 = . :
File name: ce+ html - i;l*Word Documents (*.doog" v |
1 Took ~ [pen ) [ Gocel]
| (&= %y
Open Read-Only
Open as Copy
z % Open in Browser
File openoptions == A Tt
Open in Protected View
Open and Repair
\ R :

This will open your selected file. You can use the Open Read-Only option if you are willing
just to read the file and you have no intention to modify, i.e., edit the file. Other options
can be used for advanced usage.
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End of ebook preview
If you liked what you saw...

Buy it from our store @ https://store.tutorialspoint.com
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